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Responsibi l ity. Accountabil ity. Culpabil ity.

I t seems that, in today’s world, the “abil ity” to accept
any “bil ity” (unless it’s a disabil ity) is sadly and sorely
missing.

Unlike in the time when I was growing up, along with
every generation before that, no one today takes
responsibi l ity for their own actions. I t’s always the
“blame game” where it is someone else’s fault for
one’s fail ings. Didn’t get a coveted job? I t was the
hiring manager or HR person’s fault. Didn’t get that
last promotion? The boss didn’t “l ike” me. The list of
excuses, as Buzz Lightyear would say, goes “to
infinity and beyond,” with each one twisted around
and customized to relieve the “aggrieved” party of
any self responsibi l ity.

While these situations can and do happen, their
frequency is far less than we’re made to believe or
think. Never mind that you might not have been the
most qualified candidate for that coveted job. Never
mind that maybe someone else showed more/better
leadership potential for that promotion. I t’s far, far
easier to blame someone else for one’s fail ings than
it is to take responsibi l ity for those fail ings.

A little introspection can go a very long way in these
cases. But as long as the “aggrieved” party refuses
to acknowledge and accept responsibi l ity for the
“failure,” there can never be any introspection. That
introspection may prompt the “aggrieved” party to
seek additional training or schooling to better
position themselves for that next coveted job
opening or promotion. Without accepting
responsibi l ity, the “blame game” continues on, ad
nauseum, over and over and over again.

Related to responsibi l ity is accountabil ity. In fact,
“responsibi l ity” is l isted as a synonym for

“accountabil ity” in the dictionary. Even though the
dictionary lists them as synonymous, I see them as
separate. There’s not many degrees of separation,
but I sti l l view them separately. In my mind anyway,
accountabil ity means a wil l ingness to accept the
consequences of your actions. I t also means that
you own up to your own mistakes, shortcomings,

and faults. Just as they preach in many of the 12
step programs, admitting that you have a problem is
50% of the solution.

Culpabil ity, again in my mind, is a combination of
accepting responsibi l ity AND accountabil ity in any
given situation. You openly admit your shortcomings

From The Chief Editor's Desk. . .
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(or that you are in error), and you are accountable
for your actions (you accept the consequences of
your actions).

Look around. I t’s actually quite easy to see
examples of people who accept responsibi l ity, take
accountabil ity, and who admit culpabil ity. They are
the rare breeds. I t’s that rarity that makes it easy to
single them out from the masses, who by and large,
don’t do any of those things. Even most of our
vaulted leaders are devoid of these qualities. Some
possess none of them at all .

We’ve made it very easy in today’s society for
virtually no one to take responsibi l ity for the things
that go on in their l ives or for their actions. No one is
held accountable, as the rest of the masses rise up
and coddle the “aggrieved” with excuses for the
“aggrievance.” And, if you don’t have both of the first
two traits (most don’t even have one), there can
never be any culpabil ity.

And you wonder why society has deteriorated to
such a sad state?

**********

This month’s cover commemorates the 52nd
anniversary of mankind’s first steps on another
celestial body with astronauts Neil Armstrong and
Buzz Aldrin walking on the moon, July 20, 1969. I f it
had happened today, I ’m sure Tux would be right
there to return Armstrong’s salute, as he is in the
cover image “enhanced” by Meemaw. Here’s to
hoping that mankind’s return to the moon wil l involve
Tux … and Linux (I ’m almost certain that it wil l ! ).

**********

Unti l next month, I bid you peace, happiness,
serenity and prosperity.

Screenshot ShowcaseScreenshot Showcase

Posted by Yankee, on June 1 , 2021 , running Mate.

From The Chief Editor's Desk...
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by Paul Arnote (parnote)

Goodbye, net_applet. Hello, Network Manager.

After using a combination of PCC (PCLinuxOS Control Center) and net_applet to
manage internet connections under PCLinuxOS for YEARS (pretty much since its
inception), PCLinuxOS made the switch to Network Manager in early June 2021.
Network Manager also replaces the lesser used (but very capable) wicd program.
Network Manager has become the default network management tool in most
Linux distributions in recent years. I t debuted in November 2004, first introduced
by Red Hat, so it’s definitely not a youngster.

As a result, there is a LOT of information out there about Network Manager
(henceforth referred to as NM). In fact, there’s so much information available, it
may become a daunting challenge to find the information you seek. Indeed, users
could experience “information overload” when searching out information on NM,
which could make it difficult to discern what information is needed for a particular
issue.

While I ’ l l give you a list of some resources to explore as you get accustomed to
NM (at the end of the article), let’s spend more time explaining the best way to
get your network up and running after this huge change to the PCLinuxOS
landscape.

Trust me. My first time through this on one of my computers was not a joyous
affair. I t took me about three hours to figure things out. I should have written
things down from the forum before I started, but I didn’t. So, I repeated the
process on my “travel” laptop, leveraging what I learned in the first attempt, and
after going back to the forum to figure out where I erred in my first attempt. What
fol lows is the benefit of my trials and tribulations, coupled with information
gleaned from the various threads about NM in the PCLinuxOS forum.

Step One: Start With A Clean Slate

Go ahead and run updates on your computer. NM wil l only be installed from the
PCLinuxOS repository when you specifically select to install it. When you do
decide to install it, you wil l also want to install networkmanager-applet (named
nm-applet). For whatever reason, the networkmanager-applet is not installed

automatically, and you wil l need to mark it for installation. The networkmanager-
applet is for any desktop, and allows users easy control of their network
connections. KDE users wil l also want to install plasma-nm-applet, plasma-nm-
applet-openvpn, and its other associated plugins, which is specifically for KDE
and LXQt users to control their NM connection. I ’ve been told by tbschommer that
the plasma NM applets wil l work on GTK desktops, such as Xfce. Since I run a
GTK desktop, I prefer to run the GTK plugins. Once you install NM (and it’s
applets), your current net_applet and/or wicd tools WILL stop working. You
will lose your internet connection, but DON’T FREAKOUT.

Now would also be a good time to install any NM plugins that you think you might
need from the PCLinuxOS repository. I f you connect via a VPN, you wil l definitely
want to install the NM plugin for OpenVPN. I f you’re in doubt, just go ahead and
install al l three of the NM plugins that are listed in Synaptic. That way, they are
available for any future use.

By all means, RESIST the urge to uninstall drakx-net. Even though it’s “load” has
been significantly l ifted by NM, it IS sti l l necessary for the proper functioning of
your system.

After install ing NM, go back into Synaptic and uninstall net_applet and/or wicd.
You won’t need them any longer. I f you have net_applet or wicd set to autostart
on your computer, remove it from the programs you’ve queued up to
automatically start when you login to your computer.

So, up unti l now, PCC and net_applet (or wicd) have been doing an admirable job
of managing your network connections. But now, with NM being the “new kid on

Network Manager:
The Low-Down On Getting Up To Speed
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the block,” that all changes. As counterintuitive as it might seem, you wil l need to
clear out all of the saved networks that were previously managed by PCC and
net_applet (or wicd). But, DON’T do this before you’ve run updates and installed
all of the Network Manager programs!

We need to get rid of all of the existing network connection information, and let
NM start afresh. One way to get rid of existing network connections is to go into
PCC > Network & Internet > Remove a connection. Use the dropdown box listing
all of your saved connections, and delete them, one by one. However, there have
been reports in the PCLinuxOS forum of that being a hit-or-miss endeavor. The
other, more certain way, is what Texstar calls the “nuclear option.” Open a
terminal session, and su to the root user. Then, enter the three following
commands:

rm - f /etc/sysconfig/network- scripts/ifcfg- eth0
rm - f /etc/sysconfig/network- scripts/ifcfg-wlan0
rm - f /var/lib/NetworkManager/*

PLEASE … remember that you are executing these commands as the root user,
so exercise care and precision when performing these actions. The “nuclear
option” really is the express lane to getting NM properly set up.

I f you don’t want to enter these commands yourself manually (or aren’t
comfortable working at a root prompt in a terminal session), don’t despair. Texstar
has created a new package, called “netnuke” that performs these actions for you.
Here’s the description from Synaptic:

A command line program to nuke your network connections. Run netnuke as root in a
terminal then reboot and set up your network connection through the networkmanager
applet.

Also, once you’ve got NM, the applet, and any/all the plugins installed, add nm-
applet to automatically start when you boot your computer. This way, you won’t
have to manually start it. Just. In. Case. I f you end up with it in there
unnecessari ly, or find it in your l ist of startup applications multiple times, you can
always delete it/one of them later on.

Then, reboot. When your computer has rebooted, use NM to set up your network
connections, which is what we’l l discuss next.

Step Two: Set Up Your Network Connections Using NM

Believe it or not, now comes the easy part.

Left-cl ick your mouse pointer on the NM applet icon in your system tray. You may
need to wait for a few seconds, but NM wil l locate and list all of the networks it
finds. Select the network you want to connect to. The network you are currently
connected to is shown in bold type, as displayed in the above images of the NM
left-cl ick menu (if you’ve already connected to a network). NM wil l l ist the five
networks with the highest signal strength, or so it seems (left image). All of the
others are listed under the “More networks” menu entry (right image). Networks
marked with a signal strength indicator and a small padlock require a password to
be able to connect to them.

Network Manager: The Low-Down On Getting Up To Speed
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I f the network you select is password protected (and many are), you wil l see the
dialog box above (previous page). Enter the password for the network in the
“Password” text entry box. I f you want to see the password (to ensure that you’ve
typed it in correctly), check the “Show password” checkbox. Then, cl ick the
“Connect” button at the bottom right of the dialog box.

Don’t worry. NM wil l automatically remember all the connection details for the
networks you’ve connected to, including the passwords. That way, the network is
readily available for you to connect to again, in the future.

I f you right-cl ick your mouse pointer over the NM icon in the system tray, you get
some additional choices. The first three items, represented by checkboxes in the
menu, should be self explanatory, so we’l l skip over these, as they require no
explanation. The same applies to the last item in the right-cl ick menu.

Selecting the fourth item, “Connection information,” wil l give you a dialog similar
to the image above (bottom, previous column). That dialog box wil l provide all
sorts of information about your connection.

Tweaking Your Connection

Selecting the “Edit Connections…” menu item from the right-cl ick menu brings up
a dialog box similar to that pictured above. Selecting the category of connection
and then the “+” button at the lower left of the dialog box wil l al low you to set up a
new connection. Similarly, double clicking an existing connection (or single
clicking it, then hitting the “*” button at the bottom left of the window) wil l al low
you to edit the information for that connection.

The place where breaking news,
BitTorrent and copyright collide

Network Manager: The Low-Down On Getting Up To Speed

http://torrentfreak.com/
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When you select to edit an already established connection, this is the dialog box
and view you initial ly see. I t always opens to the second tab, at least in the case
of a wifi connection. The top text entry box allows you to name the connection
whatever you want to call it. I t defaults to the SSID of the network you are
connecting to. Generally, you wil l be just fine accepting the defaults under this
tab.

Under the “General” tab, you can adjust the priority of automatically connecting to
the specific network. Higher numbers give higher priority. Place a checkmark in
the box if you want the network to be available to all users. I f you use a VPN, you
might want to check the box to automatically connect to the selected VPN (via the
dropdown selection box) when the connection is established.

Network Manager: The Low-Down On Getting Up To Speed

http://www.linuxforum.com
http://www.pclinuxos.com


PCLinuxOS Magazine Page 9

“Wi-Fi Security, ” the third tab, is exactly what you think it is. I t’s where you can
change/set the encryption type and password for the selected wifi network. Place
a checkmark in the checkbox if you want to view the entered password.

I f you typically use a different DNS service than the one provided by your ISP,
such as Google or Cloudflare, the “IPv4 Settings” tab is where you wil l specify the
address(es) for your DNS service. I use Cloudflare to help prevent a DNS leak
(you can test for a DNS leak at https: //dnsleaktest.com/), which can expose more
information about your travels around the web than you might l ike, as well as
expose you to malware and malicious sites. Enter the primary and secondary
DNS addresses, separated by a comma and space, as I have them entered
above. Other popular DNS services include OpenDNS (208.67.222.222 (primary)
and 208.67.220.220 (secondary)), and Google (8.8.8.8 (primary) and 8.8.4.4
(secondary)).

The PCLinuxOS Magazine

Created with Scribus

Network Manager: The Low-Down On Getting Up To Speed
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Troubleshooting

Some users have expressed some “issues” with NM not connecting on a reboot.
For whatever reason (that yodelu is working on in the NM package), NM reports
that it is not running and is locked. At a root terminal prompt (signified by a #
prompt, as opposed to the $ prompt as a normal user), enter service
networkmanager status. The response comes back networkmanager dead
but subsys locked .

# service networkmanager status
networkmanager dead but subsys locked

However, while sti l l at a root prompt, enter service networkmanager restart.
You should see the following in the terminal window:

# service networkmanager restart
Stopping networkmanager daemon:
[FAILED]
Waiting for connection:
[ OK ]

Once you “manually” restart NM, your connection should come up fairly quickly.

One user in the PCLinuxOS forum, fred84, found a workaround. From a root
prompt in a terminal session, enter chkconfig networkmanager off. Then, edit
(again, as root, and in a plain text editor) /etc/rc. local and add service
networkmanager start to the end of the fi le, on a line of its own.

I f you find that the nm-applet is not automatically starting on a reboot (you’re
missing the icon in your system tray), go check the programs you have set to
automatically start when you boot your computer. I run Xfce, and that l ist of
programs is under “Settings Manager, ” then “Session and Startup,” and then the
“Application Autostart” tab. I f you don’t see nm-applet l isted, you might want to
add it to the list of programs to automatically start when you boot/reboot your
computer. Nearly all of the Linux desktops have similar features that allow users
to specify programs to automatically start when their computer starts or reboots.
The list of programs to start automatically just may be in different locations. But,
they are there, from what I ’ve found.

The other thing you might want to do is just be patient. On my “main” laptop, I
have some kind of a weird timing issue where the wireless network isn’t brought
up right away. I t was this way under net_applet, and the same behavior exists
with NM. I f I just walk away for a few minutes, the network wil l usually be up and
working as it should when I come back to the computer several minutes later.
Fortunately for me, I don’t have to deal with this issue very often, since my “main”

laptop stays on 24/7, and I only reboot when I run updates or when the system
begins to “feel” sluggish.

Setting Up Your VPN

I hate to admit it, but setting up a VPN under net_applet and PCC’s Network &
Internet never made any sense to me. I did manage to sort of get it setup once,
with tbschommer’s assistance. But even then, the VPN connection didn’t work
all that rel iably for me. Probably the only ones that whole mess made sense to
was the person/team who originally wrote it. I could never figure out what went
where.

I l ike to use a VPN with my internet connection. My ISP (Comcast/Xfinity) has no
business knowing my business. VPNs encrypt the data between my computer
and my VPN’s server. All my ISP can see is traffic, but because it’s encrypted,
they can’t tel l what it is I ’m doing.

For example, Comcast is notorious for sending out DMCA notices for anyone
downloading torrents, whether that data is free or copyrighted. One recent thread
in the PCLinuxOS forum il lustrated this blanket policy with Comcast when it was
pointed out that someone downloading an ISO of Ubuntu received a DMCA
“Cease & Desist” order for downloading the ISO via a torrent fi le. Never mind that
the Ubuntu ISO is FOSS, and freely available to all and anyone who wants it. I
use Private Internet Access (PIA) as my VPN provider. I ’d rather avoid such
nonsense. I t’s not that I ’m doing anything “i l legal. ” Rather, I prefer the privacy and
“lack of hassle” that a VPN provides.

Well , NM makes setting up your various VPN servers child’s play, a literal walk in
the park. Kudos to tbschommer for steering me in the right direction, via a private
message on the forum. I was a little “gun shy” of trying to tackle setting up an

Network Manager: The Low-Down On Getting Up To Speed
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OpenVPN connection to my VPN provider, after having tried many, many times in
PCC … and fail ing nearly every single time.

All the way at the bottom of the left-cl ick NM menu, you’l l find the “VPN
Connections” menu entry. I f you’ve not configured any VPN connections up to

this point, the only thing populating the submenu is the “Configure VPN…” menu
selection. In either case – whether you’re setting up your first or fifteenth VPN
connection – select “Configure VPN…” from the menu.

I f you already have at least one VPN connection configured, NM wil l bring up the
“Edit Connections” dialog box. Select the “+” button at the lower left corner of the
window. I f this is your first VPN connection that you’re configuring, you’l l see the
dialog box shown below.

Network Manager: The Low-Down On Getting Up To Speed
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From the dropdown selection in the dialog box, go all the way to the bottom of the
selections and select “Import a saved VPN configuration…” from the choices. For
what it’s worth, the default selection in the dropdown selector is “Ethernet. ” Once
you’ve selected to import your VPN configuration fi le, select the “Create…”
button.

Now, go to the directory where you have all of your OpenVPN files stored. I store
mine, as the root user, in the /etc/openvpn directory. This way, they are available
to all users on my system (even though I ’m really the only user on my computer).
Either double-cl ick the *.ovpn fi le representing the VPN server you want to
connect to, or single click it and then select “Open” from the fi le selection dialog
box.

In the top text edit field, you can call your VPN connection whatever you like. I t
wil l usually default to the same name as the VPN configuration fi le for the server
you selected. In my case, the name defaulted to “denmark.” I changed it to “PIA
Denmark” to make it more readily identifiable as PIA’s VPN server located in
Denmark.

Just l ike with the wifi connections, the VPN dialog box opens with the second tab
preselected. Under this tab, you wil l simply need to enter your username
(obscured for privacy reasons in the image above), and your password (already
obscured). Click on the symbol at the right side of the password field, and select
the “Store the password for all users” option.

DOWNLOAD

Mate Desktop Connect connections in one
convenient location!

All your
PCLinuxOS

Network Manager: The Low-Down On Getting Up To Speed
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Under the “General” tab, you can decide if you want VPN access to be shared
with all users by checking the checkbox (which is the default).

Just l ike we did with the wifi settings dialog, go to the “IPv4 Settings” tab and
enter the custom DNS server settings you want to use with your VPN connection.
The format is the same. Enter the primary and secondary DNS addresses,
separated by a comma and space.

Repeat this process for each of your VPN’s servers you want to add to your VPN
Connections collection. Doing so goes quickly, and you wil l soon end up with
multiple VPN servers listed among your available VPN connections, as I have
done in the first image above in this section of the article on setting up your VPN
connection(s). In that image, I have a choice of seven different servers for my PIA
VPN service to choose to connect to (out of about 90 choices overall). I t’s a trivial
task to add more, if I feel l ike I need them.

Network Manager: The Low-Down On Getting Up To Speed
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Back under the wifi connection settings, under the “General” tab, you can select a
VPN server you want to automatically connect to when the network connection is
made. So, if you have a favorite VPN server you like to use, and if you don’t want
to risk “forgetting” to sign into your VPN (and allowing your ISP to log all of your
activity that they have no business knowing), making this selection wil l help
insure that you are always protected.

I have to attest that setting up VPN connections under NM is way, way, way
easier than it ever was under PCC. I t’s pretty much painless … and it works! NM
does a lot of the “heavy lifting” for you, so all you have to do is point it to your
VPN’s valid *.ovpn fi le, and it pretty much fi l ls in the blanks for you. Well, other
than your username and password, anyways.

Additional Resources

Like I mentioned at the outset, NM has been around for quite a while. Most other
Linux distros already rely on NM to manage network connections. In a way, they

paved the way for the ease of adoption by PCLinuxOS. They’ve already guinea
pigged it to death. So, what we get is the tried and true version, pretty much free
from the niggles that nearly always accompany “new” software.

As a result, there are a lot of resources and information about NM out there. Do
an internet search for “network manager” and you’l l retrieve a literal ton of l inks.
Below are five links that may be useful for those wishing to dig a little deeper into
NM and its associated programs (like nmcli , the command line version of NM), as
well as many configuration settings and options that we couldn’t possibly cover
here. Our goal here was to merely help you get NM up and running on your
PCLinuxOS computer.

Linux Man Pages

networkmanager.conf: https: //l inux.die.net/man/5/networkmanager.conf

NetworkManager daemon: https: //l inux.die.net/man/8/networkmanager

Manuals & Wikis

nmcli Reference Manual:
https: //developer.gnome.org/NetworkManager/stable/nmcli .html

networkmanager.conf Reference Manual:
https: //developer.gnome.org/NetworkManager/stable/NetworkManager.conf.html

Arch Linux Wiki: https: //wiki.archlinux.org/title/NetworkManager

Freedesktop.org:
https: //people. freedesktop.org/~lkundrak/nm-docs/nm-settings.html

Gentoo Linux Wiki: https: //wiki.gentoo.org/wiki/NetworkManager

There are many, many, many more reference sites for NM out there. These,
though, should get you well on your way to digging deeper into the inner workings
of NM, if you choose to do so.

Summary

Yes, change is very scary for a lot of people. But trust me when I tel l you that this
change to PCLinuxOS wil l pay dividends for years to come. First of all , it provides
a famil iar interface for users who might migrate to PCLinuxOS from other Linux
distros. We already have an ace-in-the-hole as one of the few systemd-free Linux
systems around. Second, it puts PCLinuxOS on par with the rest of the Linux

Network Manager: The Low-Down On Getting Up To Speed
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community, with most Linux distros already relying on NM for network
management. Third, it makes network management – especially the use of VPNs
– infinitely easier than we’ve ever had it.

Keep in mind that there are many different iterations of even the same “model” of
networking cards. Compound that with many different models and manufacturers,
different chipsets, and other nuances, and you have the “wild wild west” of
networking. Tuning a program like NM to work with all those different network
cards is a monumental task. Whatever you do, don’t give up. There wil l be a
solution, because NM is very flexible in dealing with those differences in
networking cards.

Even though NM isn’t new, it is new to PCLinuxOS. As with most “new” things,
there wil l be growing pains and “glitches” to figure out and iron out as we get
used to it and its l ittle niggles. Every program has them. But the positives far
outweigh the negatives, so don’t let a few little bumps in the road deter you.

So, NM is a win-win for everyone. You shouldn’t shy away from this change.
Embrace it. You wil l be glad you did.

The PCLinuxOS Magazine
Special Editions!

Get Your Free Copies Today!
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without articles to fi l l the pages.

I f you have article ideas, or if you
would l ike to contribute articles to the
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by Alessandro Ebersol (Agent Smith)

Oracle is watching you

I previously wrote about the nebulous relations of big
techs with the American spy agencies, which, by
itself, would be very worrisome. These agencies
treat citizens as if they were criminals, violating
everyone's privacy, l istening to conversations,
keeping pictures, archiving personal data, which,
normally, would only be acceptable with warrants
issued by judges. But no, they act clandestinely and
outside of the law(s). This alone would be very bad.
But research for writing is an interesting activity, as
Forrest Gump would say, when you open a box of
chocolates, you never know what you wil l find. And,
research is l ike that, you start researching a subject,
and, how the thing ends, you never know. Imagine
my surprise when I found out that American
companies, big tech companies, are involved with
the Chinese government? Yes, and not that they are
spying on the Chinese government. Far from it. But
they are helping to perpetrate human rights abuses.
Exactly the same government that is openly
condemned for human rights abuses, is a first class
customer of several US tech companies.

Oracle, serving big brother...

The authorities in China are using software
developed by the American company Oracle to

monitor and enforce a kind of Minority Report-style
policing system on the Chinese population. Yes,
dystopian science fiction is becoming reality.

According to The Intercept website, Oracle's
products are being used by various law enforcement
agencies in China to analyze vast amounts of data,
which is then used to surveil and track citizens. One
such place where Oracle's technology is being used
is the concentration camps in Xinj iang, where the
Chinese communist government has detained up to
two mil l ion members of the Uyghur ethnic minority
along with an unknown number of political prisoners.

However, things get worse, as mentioned in the
above mentioned Minority Report style.

Slide presentation ofOracle's products for "crime prevention”

The Dangerous Liaisons Of Big Tech Companies
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Selling technology without any ethics

Mara Hvistendahl, a writer for the Intercept website,
had access to a slide presentation from the
company where various products for "police
prediction and analysis" were demonstrated. The
slides of the presentation, hosted on Oracle's
website, begin with a "case outl ine" l isting four
"Oracle product(s) used" by Liaoning police to "do
crime analysis and prediction." One slide shows
Oracle software that allows Liaoning police to create
network graphs based on hotel records and track
anyone who might be connected to a particular
suspect. Another shows the software being used to
build a police dashboard and create "heat map(s) of
security cases." Apparent images of the software
interface show a blurred face and several Chinese
names. The final sl ide claims that the software
helped the police, whose data sets had been
"incomprehensible," more easily "track key
persons/objects/events" and "identify potential
suspects," which in China, often means dissidents.

The slideshow purportedly accompanied a
presentation given at Oracle's California
headquarters in 2018, where the province's police
were able to fi lter through large amounts of data
using Oracle's platform to identify potential suspects.

The technology essential ly allows the Chinese
government to predict and flag individuals deemed
dangerous, or potential ly dangerous, for arrest
before they even "commit a crime."
Oracle's marketing materials boast that the company
could enable Chinese law enforcement agencies to
collect information from various sources, including
social media activity, facial recognition, DNA
databases, and much more public and private data,
mining various data sources (big data mining) for
their purposes.

The slide show was here. However, the negative
backlash was so great that the slide show was
removed.

Speaking to the Intercept, Oracle spokeswoman
Jessie Moore said that the presentations were
simply theoretical and that the business the
company does in China is in ful l compliance with US
export controls and sanctions.

However, contrary to Oracle's official statement, the
slides actually show how Chinese security forces
have been using technology.

According to Xavier Lopez, former senior director at
Oracle, "The provincial police in China used the
software. The data didn't come from us. The data
came from the province. The province uses the
software, they license the software to use for
different things, for different use cases. And this was
an example of when they used it for that particular
use case."

Double standards

All said, the documents paint a disturbing picture of
a technology company sacrificing its professed
values to push its data analytics products in China,
where the most formidable data collector is the
Chinese government.

Oracle's presentations on China's security apparatus
raise a number of serious questions for the
company, which is entangled with the US defense
establishment. I t said last year that its customers
include "all 5 branches of the U.S. mil itary," and has
recent or pending contracts with NASA, the
Commerce Department, and the CIA. Oracle has
also worked closely with police departments in the
US.

However, Larry Ell ison's hypocrisy is stunning. Co-
founder and Chairman of the Board Larry Ell ison
criticized Google's 2018 plans for a censored
Chinese search engine, tel l ing Fox Business, "We
have serious competition with China. I 'm on Team
USA." The fact that Google "is going to go into China
and facil itate the Chinese government to surveil its
people is pretty shocking," he added.

But, it gets worse. Way worse.

The Man Who Sold the World (or at least 300
mill ion people)

Oracle has always been close to the U.S.
government, working with the CIA as one of its first
customers, so much so that Oracle's work with the

Attempt to access Oracle's propaganda brochure for the Chinese government

The Dangerous Liaisons Of Big Tech Companies
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government (Safra Catz, Oracle's CEO, was in the
Trump administration's transition cabinet in 2016)
helped it and Walmart outmaneuver its rivals in an
attempt to control U.S. operations for Chinese-
owned social media company TikTok last year, after
the Trump administration ordered TikTok to find a
U.S. buyer for its American operations. The
proposed deal, under challenge in court, was
motivated by concerns that TikTok's Beij ing-based
parent company could pass on sensitive user data to
Chinese authorities. But in a strange twist, the
documents show that Oracle marketed the use of its
software to those same authorities in an extreme
example of putting profit above human rights.

Tik Tok, another surveillance social network

Oracle's interest in both TikTok and data-driven
policing is a result of its continued push into the
growing cloud market and the related expansion of
its artificial intel l igence offerings. The company's
roots are in database software, but over the past
decade it has acquired several online search
engines and data analytics startups. Oracle has also
become a big data broker. I t claims to sell data on
more than 300 mil l ion people worldwide - what it
calls "the largest collection of third-party data in the
world. "

"Companies should not sell any kind of predictive
surveil lance system to the Ministry of Public
Security," said Maya Wang, senior researcher at

Human Rights Watch in China, who was among a
group of experts who reviewed some of Oracle's
presentations, The Intercept has obtained. "They
shouldn't have any business with the Ministry of
Public Security. "

"This raises questions about the role the West has
played in inspiring and building surveil lance systems
in China."

Besides the human rights concerns, the documents
point to deep national security issues. One of the
mil itary-oriented submissions cites Oracle's defense
work in the U.S. in an apparent effort to win Chinese
cloud contracts. "The fact that an American
technology company is marketing capabil ities to
enhance the combat power of the Chinese mil itary is
definitely poor judgment, especially given how
eagerly Oracle continues to seek opportunities to
work for the Department of Defense," said Elsa
Kania, a fellow at the Center for a New American
Security and an expert on Chinese mil itary strategy,
after reviewing the relevant documents. "I t says
something about the pursuit of profits and market
share over issues of ethics and due dil igence."

Oracle, exporting repression today

Oracle's efforts are part of an overall shift toward big
technology entering policing, in which more niche
companies like Palantir and PredPol are being
edged out by large platform companies like Amazon,
IBM and Microsoft. Oracle's data analytics software
and applications have been used by the Chicago
Police Department and the I l l inois State Police, as
well as by several local governments in the United
States.

But Oracle has also marketed police applications of
its software in countries with deplorable human
rights records, including not only China, but also
Brazil , Mexico, Pakistan, Turkey, and the United
Arab Emirates, according to company documents
and police contracts uncovered by The Intercept, as

well as presentations by Oracle employees
uploaded to Slideshare and other sites. The
documents make clear that the software could be
used for additional surveil lance. An Oracle global
marketing brochure from its website notes that police
"need crime analysis and social media analysis in a
single source." Another implies that Oracle's
software could help police fi lter 700 mil l ion
messages a day from major social media
applications-including WeChat and Weibo, as well
as "chat rooms, forum pages, reviews, and news
media." Under "Barriers to Overcome," it l ists
"privacy protections."

"We have a lot of evidence of the negative potential
of this type of technology for the black and
peripheral population" in slums and other poor
neighborhoods in Rio de Janeiro, said Pablo Nunes,
a researcher at the Rio-based Center for the Study
of Security and Citizenship. "I t also reinforces the
criminalization of certain spaces in the city. "

Oracle is a bad company, unpatriotic and
unprincipled

Yes, that is true. But, it's not only Oracle. We have
Google trying to sell its search business in China,
with a modified search engine, and we also have
another one, our old acquaintance, that has been
collaborating with the Chinese government since the
2010s. Yes, I mean Microsoft, the good old
Microsoft. Of course, the ties of Microsoft with the
Chinese government can be traced way back, but I
only “scratched the surface”, so to speak.

Microsoft and Oracle: Partners in Crime

Back in 2013, Microsoft fi ltered words from Chinese
Skype users, in conjunction with Chinese provider
Tom Online, it offered a modified version of its
communication app. When a TOM-Skype user sent
chat messages containing "suspicious" language
found within the program's periodically updated

The Dangerous Liaisons Of Big Tech Companies
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keyword list, an alert was sent to TOM-Skype's
servers containing the sender's account name, the
time stamp of the message, and the detected
word(s).

This censorship and surveil lance scheme was
discovered by Jeffrey Knockel, a 27-year-old
graduate student (at the time) at the University of
New Mexico, who decoded and published a list of
the words that cause Skype to block messages or
forward them to Chinese servers.

In 2019, it came to light that Microsoft has been
working with a mil itary-run Chinese university on
artificial intel l igence research that could be used for
surveil lance and censorship, a revelation that has
sparked outrage from China's opponents on Capitol
Hil l .

Three papers, published between March and
November last year, were co-written by academics
at Microsoft Research Asia in Beij ing and
researchers affi l iated with China's National
University of Defense Technology, which is

control led by China's top mil itary body, the Central
Mil itary Commission.

One of the papers described a new AI method for
recreating detailed environmental maps by analyzing
human faces, which experts say could have clear
applications for surveil lance and censorship.

The paper acknowledges that the system provides a
better understanding of the surrounding environment
"not seen by the camera," which could have a
"variety of computer vision applications."

Samm Sacks, a senior fel low at think-tank New
America and an expert on China technology policy,
said the documents raised "red flags because of the
nature of the technology, the author's affi l iations,
combined with what we know about how this
technology is being deployed in China right now."

"The [Chinese] government is using these
technologies to build surveil lance systems and to
detain minorities [in Xinj iang], " Ms. Sacks added.

The U.S. government is debating whether research
collaborations, particularly in sensitive areas such as
artificial intel l igence and augmented reality, should
be subject to stricter export controls.

Microsoft and Huawei, a happy marriage

President Donald Trump signed an executive order
banning Huawei products in American homes.
Huawei not only works closely with the Chinese
government to monitor citizens through technology
and AI , but is also under investigation for working to
subvert the US-Iran nuclear weapons agreement.
Huawei is blacklisted on the U.S. Department of
Commerce's Export Administration Regulatory
Entities List.

Microsoft has temporari ly complied with the Huawei
ban and stopped sell ing the company's laptops
online. However, after evaluating the extent of the

regulations, Microsoft agreed to continue sell ing the
existing stock of Huawei laptops in its Microsoft
store. In fact, Microsoft is proud of its work with the
telecommunications industry in China, which must
comply with the Chinese government's rules.

"Today, our most complete subsidiary and largest
R&D center outside the United States is in China,"
Microsoft's official website says. "Microsoft boasts a
robust partner ecosystem with 17,000 partners. For
every RMB Microsoft earns in China, Microsoft
partners earn 16." Because of its local product
strategy and "commitments to helping Chinese
partners," Microsoft prides itself on being one of
"The Companies Remaking The Chinese Economy."
Their success in China comes at a cost, as they
please the Chinese government and help develop
products that compromise privacy, which implies
American security, at home and abroad.

Microsoft's submission is complete

More recently, on June 3rd, 2021, the 32nd
anniversary of the Tiananmen Square massacre,
interestingly enough, if one were to search for "Tank
Man" on the Bing search engine, one would get the
answer below:

Huawei notebook sold at Microsoft store

The Dangerous Liaisons Of Big Tech Companies



PCLinuxOS Magazine Page 20

Unlike its main search engine competitor Google,
Bing has been allowed to operate within China.
Microsoft has to censor Bing search results for the
Chinese government, but on Friday, 06/04/2021,
Bing users in other countries, including the US, UK
and Singapore also found the "Tank Man" images
missing.

The lack of search results for the phrase "Tank Man"
led to accusations that Microsoft was censoring the
image on behalf of the Chinese government. The
BBC reported that a Microsoft spokesperson said
the issue was "due to an accidental human error and
we are actively working to resolve this. "

Microsoft's response to the incident earned mockery
from Senator Ted Cruz (R-TX). Cruz tweeted, "Was
the 'accidental human' who made the mistake by
chance Microsoft's head of Marketing for China?

Profit above all.. .

I t is not only the big tech companies that try, by all
means, to please the Chinese government. Media
companies, cinema, TV, comics, books, and even
video games, all try to gain the favor of the Asian
giant, and especially to win a potential market of 2
bil l ion people. However, in this blind race for profits,
many things get lost along the way. And these losses
can be costly for everyone, as disastrous maneuvers
by these companies can put everyone's future in
danger.

Screenshot ShowcaseScreenshot Showcase

Posted by tuxlink, on June 5, 2021 , running KDE.
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by Paul Arnote (parnote)

Dumb Criminals: He Should Have Worn Gloves

A drug dealer in Liverpool, England gave the
authorities all they needed to locate and apprehend
the suspect … from a social media post he made of
himself holding a wedge of sti lton cheese, according
to an article on The Verge.

Police authorities were able to view fingerprints in
the detailed photo posted online, leading them to the
drug dealer’s whereabouts. Let this serve as a
reminder that while your fingerprints are unique to
you, they are not so private, especially when you go
posting their images (knowingly or unknowingly) on
the internet. That was his first mistake that led to his
capture.

His second mistake came from posting the picture to
EncroChat, an encrypted phone system that –
unbeknownst to the suspect – had been
compromised by authorities last March. That left the
encrypted service with more holes than Swiss
cheese (pun intended). Since then, authorities have

identified around 10,000 of its users in the UK, who
are “all involved in coordinating and planning the
supply and distribution of drugs and weapons,
money laundering and other criminal activity, ”
according to authorities, who say that a total of
60,000 of its users have been identified worldwide.

The suspect was subsequently sentenced to 13
years and six months in prison after pleading guilty
to the charges, which also included transferring
criminal property. Those charges also included
conspiracy to supply cocaine, heroin, MDMA, and
ketamine.

He should have worn gloves.

John McAfee, Founder Of McAfee Anti Virus,
Found Dead In Spanish Jail Cell

John McAfee, the creator and founder of McAfee
antivirus software, was found dead in his Spanish
jai l cel l from an apparent suicide. McAfee, 75, was
awaiting extradition to the U.S. to face tax charges
that, if convicted, would have resulted in a multi-
decade long prison term in the U.S. He was arrested
at the Barcelona airport last October, and remained
in the Spanish prison since that time, awaiting the
extradition hearing for his U.S. tax law charges.

A well known cryptocurrency promoter and tax
opponent, McAfee was discovered in his Brians 2
penitentiary cell in northeastern Spain, near
Barcelona. Prison personnel attempted to revive
him, but the prison’s medical staff ended up
pronouncing his death. Despite being initial ly ruled a
suicide, a judicial delegation is launching an
investigation to ascertain the cause of death.

McAfee’s suicide occurred just hours after a Spanish
court approved his extradition to the U.S. to stand
trial for the tax law infractions. The court’s rul ing was
eligible for appeal, and any final determination on
extradition would have had to come from the
Spanish cabinet. McAfee had previously stated that
he had no plans or desire to return to the U.S.
Reports on McAfee’s death were widely circulated in
both the mainstream and computer media outlets.

John McAfee, 2016, speaking at Politicon in Pasadena,
CA. Photo by Gage Skidmore, CC BYSA 3.0

Short Topix: Windows 11 Announced,
Expected By Year's End

https://www.theverge.com/tldr/2021/5/24/22451278/cheese-encrochat-drug-dealer-jailed-conviction


PCLinuxOS Magazine Page 22

McAfee once launched two long-shot presidential
campaigns (2016 and 2020), and as recently as
2016, participated in the Libertarian party
presidential debates. He was a popular speaker in
many circles. In 2012 he was wanted for questioning
in connection with the death of Gregory Viant Faull ,
who was shot to death in early November 2012 on
the Belize island where the men lived. He was often
described as paranoid, even going so far as to
granting a television news interview, but only if he
could hold a loaded pistol in each hand. McAfee’s
company was purchased in 2011 by Intel, who
folded it into their cybersecurity division to dissociate
the brand from its founder.

Controversy is already swirl ing around his death.
There are many people who are claiming that
McAfee met the same fate as Jeffrey Epstein, and it
wasn’t suicide. Even McAfee’s wife has come out
and stated that there is no way that McAfee would
have committed suicide. Since his death occurred in
a lonely Spanish prison cell , no one on this Earth wil l
ever know for sure, and anyone who claims
otherwise is just speculating based on circumstantial
evidence.

Windows 11 Announced, Expected By Year’s End

Well, it shur duz look purdy! But then again, so does
lipstick on a pig.

Microsoft announced the newest version of it’s
operating system, Windows 11, on June 24. In the
pictures that they have released, Microsoft has
tinkered with the “taskbar” again, moving the “Start”
button – and all of the “taskbar” buttons, for that
matter – to the central part of the bottom of the
screen, reminiscent of how a docker toolbar might
appear on Linux or on a Mac. Originality … er,
mimicry … at its finest!

You’re going to LOVE the system requirements.

Seriously? 64GB of storage?! I can install
PCLinuxOS on x86 hardware with only 32GB of
storage space. The system files (root partition) wil l
take up 12GB, 4GB can be assigned to swap, and
16GB can be used for a /home partition. Granted,
that’s not a lot of storage space for my personal fi les,
but then I could use an attached USB drive for all my
storage, if push came to shove.

To spur adoption of Windows 11, Microsoft is
providing a FREE upgrade path for Windows 10

Source: Microsoft,
Windows Specifications
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users. The upgrade offer wil l commence from its
release, into 2022.

One new feature of Windows 11 is the abil ity to run a
user’s favorite Android apps on a Windows 11
desktop. Except, it l inks to apps in the Amazon App
store, instead of the Google Play store. The
selection in the Amazon App store is miniscule,
compared to the offerings in the Google Play store. I t
also features Chat for Microsoft Teams integrated
into the taskbar to help keep you connected to the
people you want to … connect to. Microsoft is also
targeting gamers, and is offering special (translation:
paid) access to over 100 games, with more being
added all the time (their words, not mine). A
revamped Microsoft Store helps connect users to
entertainment options, such as Disney+, Netfl ix,
Spotify and others.

Many of the computer media types think that
Microsoft is being a bit overly optimistic about an
end-of-the-year release date. I guess we’l l al l see
what the next six months brings.

Jonah Reincarnate?

A New England lobster diver near Provincetown, MA
got to experience, first-hand, how things might have
felt for Jonah when he was swallowed by a
humpback whale while diving for lobsters.

Professional lobster divers l iterally pick lobsters off
the sandy bottom of the ocean.

Michael Packard, 56, made his first dive a little
before 8 a.m. on June 11. Donned with scuba gear,
he dove to the sandy bottom in the 60° F water,
where he saw other fish scurrying about. Then,
about 10 feet from the bottom, he felt a shove and
everything went dark.

“All of a sudden, I felt this huge shove and the next
thing I knew it was completely black,” Packard
recalled Friday afternoon following his release from
Cape Cod Hospital in Hyannis.

“I could sense I was moving, and I could feel the
whale squeezing with the muscles in his mouth,” he
said.

Packard initial ly thought he was inside a great white
shark, but couldn’t feel any teeth and discovered he
didn’t have any wounds. At that point, he realized
that he had been swallowed by a whale.

“I was completely inside; it was completely black,”
Packard said. “I thought to myself, ‘there’s no way
I ’m getting out of here. I ’m done, I ’m dead. ’ All I
could think of was my boys — they’re 12 and 15
years old. ”

Donned in scuba gear, Packard began to struggle.
The whale began shaking his head, so it was
apparent that the whale didn’t l ike what it had
ingested. Packard estimated that he was in the
whale for 30 to 40 seconds before the whale finally
surfaced. He saw light and the whale threw its head
from side to side. And the next thing Packard knew,
he was outside of the whale and in the water.

Humpback whales are not aggressive animals,
particularly towards humans. I t appears that
Packard’s ingestion by the whale was most l ikely a
mistake, and most l ikely by a juvenile feeding on fish
in the area. When a humpback whale feeds, it’s
mouth opens like a large parachute, and whatever is

in their path is swept up. The large, bi l lowing mouth
blocks their forward vision, so the whale never knew
that it had ingested something it did not want to eat.
Even though Packard fit into the whale’s mouth, its
esophagus is too small to ful ly swallow a human.

Packard suffered some soft tissue injuries from the
ordeal, and plans to return to lobster diving once he
has healed.

If You Thought Google’s Evilness Was Limited To
The Internet, You’d Be Wrong

The story about the origins of COVID-19 continues
to be played out l ike a poorly acted horror fi lm.
EcoHealth All iance, headed by Peter Daszak, has
been deliberate and one of the principal players in
trying to debunk the lab origins of the virus, despite
mounting evidence that the virus had indeed
escaped from the Wuhan Institute of Virology.
Daszak was one of the members of the WHO team
who set out to attempt to find a naturally occurring
evolution of the virus.

The plot and number of “players” in this drama
continue to thicken and deepen. I t has now come to
light, by way of investigative journalists and
published on The National Pulse website, that
Google has funded EcoHealth All iance for more than
the past 10 years. Through the nonprofit
foundation/charity arm of the tech giant known as
Google.org, Google funneled money to EcoHealth
All iance to fund research on bat coronaviruses. That
money, conceivably, could have also been used to
fund the “gain of function” research that aided the
virus to jump species from bats to humans.

Short Topix: Windows 11 Announced, Expected By Year's End

https://thenationalpulse.com/exclusive/google-funded-wuhan-linked-ecohealth-research/
https://google.org/


PCLinuxOS Magazine Page 24

This story continues to evolve at break-neck speed.
However, I doubt that we’l l ever know the whole
picture of this biological debacle that has stained
humanity. Let’s hope, though, that we learn enough
to help prevent another similar occurrence from
happening again in the future. The next time, we
might not be so lucky as to be able to contain it or
find a vaccine or treatment.

PCLinuxOS Short Topix Roundup

YOU SURE YOU WANT THAT NEXT CUP OF
COFFEE OR THAT NEXT COLA? Researchers
have found that regular caffeine intake causes the
gray matter in our brains to shrink. They conducted a
study that compared caffeine recipients to those
receiving a placebo. Even though the effects are
temporary and transient, a shrinkage of gray matter
was found in the caffeine recipients. Researchers
were especially intrigued by how striking the
difference was in the right temporal region of the
brain and the hippocampus, which is essential for
memory consolidation. Researchers cautioned
against saying that caffeine had a negative impact

on our brains, but did indicate that this study could
pave the way for future studies exploring the effect
further.

The BBC had a very interesting article on how to
RECYCLE ALL PLASTICS BACK INTO THE OIL
FROM WHICH THEY CAME. Up unti l recently, the
process consumed more energy than it took to
create new plastics from oil . But new advances put
the process more within our reach. By converting
plastics, which take forever to break down in landfi l ls
(if they ever even do), back into the oil from which
they came, that oil could be used to create new fuels
or to even create new plastic items. The BBC calls it
“infinite plastics, ” since the reclaimed oil can be used
to create new plastics.

The United States Air Force is looking at USING
THE STARSHIP ROCKET BOOSTERS to deliver up
to 100 tons of supplies or personnel to any place on
the planet in one hour or less. The rockets would
carry the same payload as the current C17 cargo
planes, but be able to deliver the payload to any site
in the world in one hour or less. The USAF is looking
to put the idea to test sometime in 2022.

You can thank a GLOBAL NETWORK OF
AMATEUR SLEUTHS who formed a network called
D.R.A.S.T. I .C. for uncovering much of what now
appears to be the lab-leak origins of the SARS-CoV-
2 virus, causing the COVID-19 pandemic. They
poked and prodded around in obscure online
databases from around the world to find the clues
that helped put the puzzle pieces of the virus’s origin
into place. D.R.A.S.T. I .C. stands for “Decentralized
Radical Autonomous Search Team Investigating
COVID-19.”

As the month of June commenced, reports were
plentiful about how PEOPLE WHO HAVE BEEN
WORKING FROM HOME DURING THE
PANDEMIC ARE NOW RELUCTANT TO RETURN
TO WORKING IN AN OFFICE. In fact, the pushback
from employees is so strong that many are choosing
to quit their jobs altogether, rather than return to the

office to do the same work they were performing
from home. The pandemic forced many to work from
home, and in the process, those employees found a
more satisfying and rewarding balance between
work, family and home life. So much so, that they
now are hesitant … no, reluctant … to give up the
new, preferred work-home-family balance.

The eyes may be the “window to the soul, ” but they
also may be a window into the mind. According to an
article that appears in Scientific American, PUPIL
SIZE IS AN INDICATOR OF INTELLIGENCE. The
larger the pupil , the greater the intel l igence. The
report is a fascinating look at why researchers think
this is so.

In May 2021, a hacker group known as DarkSide
disrupted pipeline operations for Colonial Pipeline
with ransomware, sending gasoline prices soaring in
the U.S. In June 2021, FEDERAL INVESTIGATORS
MANAGED TO RECOVER 63.7 OF THE 75
BITCOINS COLONIAL PAID IN RANSOM to
DarkSide, according to a TechRepublic article.
Because of the volati l ity of bitcoin, that represented
approximately $2.3 mil l ion of the $4.4 mil l ion
ransom, due to the price of bitcoin dropping since
the time the ransom was paid.

I f you needed more proof that YOUR PERSONAL
DATA IS FOREVER AT RISK, there were two
reports of HUGE data breaches this past month.
From one TechRepublic article, a hacker released a
100GB text fi le containing 8.4 bil l ion passwords onto
a popular hacker forum. Security personnel think
that the fi le contains passwords accumulated from
previous data breaches. This should serve as a stark
reminder to NEVER reuse passwords between sites.
In another article on ArsTechnica, researchers from
NordLocker uncovered a mystery piece of malware
that is yet unnamed. That malware has collected a
dizzying 1.2TB of data from PCs, including login
credentials, email addresses, browser cookies,
autofi l l information, and payment information. The
data was extracted/mined from more than 3 mil l ion
PCs from between 2018 and 2020.

Short Topix: Windows 11 Announced, Expected By Year's End
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Thanks to the impending release of Windows 11 at
the end of the year, TPM 2.0 CHIPS HAVE
QUADRUPLED IN PRICES, according to an article
on CNX Software News. Sometimes, that increase
occurred in less than 12 hours after the
announcement of the Windows 11 release. Prices
went from just under $25 to nearly $100. Many
outlets are simply sold out of the TPM 2.0 chips.
TPM stands for Trusted Platform Module, and
without TPM 2.0, Windows 11 wil l not install on a
PC, regardless of how “powerful” your PC is. You
could have an i9 Intel processor with 64GB RAM,
and without a properly installed or configured TPM,
Win11 wil l not install . Many PCs made and sold
since 2011 have TPM chips installed, but Windows
11 wil l “reportedly” require TPM 2.0, which was only
released in 2019. Many who follow Windows think
that Microsoft may allow a fallback to TPM 1.2,
however. They think that TPM 2.0 is a “soft
requirement, ” and that TPM 1.2 wil l be the “hard
requirement. ” Microsoft isn’t saying so official ly,
though, only that “Win 11 is sti l l in ongoing
development and months away yet so wait and see
when it's official ly released.” TPM can be set up via
a chip on the motherboard, or can sometimes be set
in a computer’s BIOS. Your mileage may vary,
depending on which computer you have.

Screenshot ShowcaseScreenshot Showcase
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Posted by The Cranky Zombie, on June 1 , 2021 , running KDE.

Short Topix: Windows 11 Announced, Expected By Year's End
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by CgBoy

Motrix is a powerful, easy to use download manager
that has support for HTTP, FTP, BitTorrent, and
Magnet l inks. Motrix can handle up to 10 active
downloads at once, and it can also accelerate
download speeds by splitting the fi les into multiple
parts, making it faster than downloading through a
regular web browser.

Motrix has a very modern and nicely designed user
interface. The main page you’re presented with
when opening Motrix is the Task List, from which you
can view and manage all of your active downloads.
The tasks can be fi ltered to show only those that are
currently downloading, waiting, or stopped, from the
Tasks panel on the left. From the sidebar on the far
left, you can access the Motrix website, the Task
List, start a new download, and open the
Preferences page. Motrix also gives you a nice
internet speed indicator down in the lower right
corner.

To add a new download, cl ick on the + button on the
far left sidebar and a small window wil l pop up. Here,

you can paste the URL or Magnet l ink to the fi le you
wish to download, or select a torrent fi le by dragging
and dropping it into the window, or opening it
manually. Then you can set the download location,
choose to rename the fi le if need be, and set the
number of fi le splits for download acceleration.
When you’re ready, just cl ick Submit and your
download wil l start and be added to the Task List.

Downloads start automatically as soon as they’re
added to the Task List, so there’s unfortunately no
way to schedule them. The controls at the top of the
Task List allow you to remove any selected tasks,
refresh the Task List, and start or pause all of the
downloads at once. Next to each task are also
individual controls for starting, pausing, and
removing the download, as well as opening the
download folder, copying the link, and opening the
Task Details page for extra information. The
individual download speeds (and upload speed, in
the case of torrents), along with the estimated time
remaining are also shown for each task. As soon as
a download finishes, the task is moved to the
Stopped tab of the Task List (top, right).

From the Preferences page, you can change a
variety of settings, such as the maximum upload and

download speeds, edit the torrent trackers list, and
you can also set up a proxy server if you so desire.
Clicking on the Lab tab of the Preferences page wil l
give you access to various browser extensions
available for Chrome and Firefox to enable
downloading fi les through Motrix.

Summary

On the whole, I found Motrix to work really well ,
without noticing any bugs or problems. The main
feature that I would have liked to have seen in Motrix
was the abil ity to schedule downloads to only start at
certain times, but that’s not a huge issue. All in all ,
Motrix turned out to be a stable, well designed, and
very easy to use download manager, perfect for any
simple tasks.

Repo Review: Motrix Download Manager

http://pclinuxos.com/?page_id=7
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Servings 4
Unit converter

INGREDIENTS:

Chicken
1 cup shredded pepper Jack cheese (4 oz) (176 g)
4 oz cream cheese, softened (112 g)
1 can (4.5 oz) chopped green chil ies (127 g)
1 package (1 oz) taco seasoning mix (28 g)
4 boneless skinless chicken breasts (6 to 8 oz each)
(170 - 226 g)
2 tablespoons olive oil (29 ml)

Topping
3/4 cup shredded mozzarella cheese (3 oz) (176 g)
1/4 cup sliced green onions (4 medium) (26 g)
1/4 cup fresh cilantro leaves (4 g)

DIRECTIONS:

1. Heat oven to 400F (204C) Line large, rimmed
sheet pan with foi l . Place a wire rack on top of foi l .
Spray with cooking spray.

2. In a medium bowl, mix pepper Jack cheese,
cream cheese, chiles and 1 tablespoon of the taco
seasoning mix. On the thick side of each chicken
breast, cut the 3-inch-long pocket to within 1/4 inch
of the opposite side of the breast. Spoon about 1/3

cup cheese mixture into the pocket in each chicken
breast. Secure with toothpicks.

3. In a small bowl, mix the remaining taco seasoning
mix and the olive oil . Place chicken on rack; brush
with oil mixture.

4. Roast uncovered for 25 to 30 minutes or unti l
stuffing reaches an internal temperature of 160F
(71.1C) Top chicken breasts with mozzarella cheese;
bake 3 to 5 minutes or unti l cheese is melted. Top
each breast with green onions and cilantro.

NUTRITION:
Calories: 560 Carbs: 10g Fiber: 1g
Sodium: 1190mg Protein: 50g

PCLinuxOS Recipe Corner

Mexican Stuffed Chicken

https://www.digitaldutch.com/unitconverter/volume.htm
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any part of the magazine is/are the person opinion of such
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PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
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by Meemaw

In May, I started a series of ways that you can
remove the background from most any photo,
referencing this video how-to on YouTube. The
author has several other videos that are very good.

This month I ’ l l finish covering the five methods.

Select by Color

This works really well with a graphic that
has a specific colored background.
Loads of clipart is made with
backgrounds that I wouldn’t mind

deleting. The one below is a cute Christmas
background, but it has that blue area behind it.

With it open in GIMP, choose the Select By Color
tool and click in the blue area. The blue and only the
blue wil l be selected with the “moving ants” to show
what’s selected. Notice that the border between the

blue and everything else is kind of dotted - in your
window, the dots wil l be moving. Remember to add
an Alpha channel! Again, if you right-cl ick on the
layer, and Add Alpha channel is greyed out, you
already have one.

Now you can press the delete key, and the blue area
wil l be transparent.

In this cl ipart, I then selected the white to delete.
NOTE: you have to be careful there because there is
some white in the eyes and mouths. After I selected
the white, I used a large eraser to erase the white
around the outside while leaving the eyes and
mouths. I f you have a certain color selected, and go
over it with the eraser, only the color you have
selected wil l be affected. For my use, I then chose
Select > None, to deselect everything, and used my
eraser to careful ly erase the black line that had been
between the blue and the white.

I exported it as a png, and though it shows a white
background here, I can insert it into another picture
and the white wil l be transparent.

Layer Mask

The layer mask is a little more involved, but it wil l
help remove a background in a photo which has
someone with wisps of hair extending into the
background. You could cut them off, of course, but

GIMP Tutorial: Removing A Background, Part 2

https://www.youtube.com/watch?v=lOzSiOIipSM&ab_channel=LogosByNick
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the photo won’t look the same. This is an image by
Esther Merbt, free on Pixabay.

Now, if I just trace around the main part of the hair
and cut off the “wild child” part on the left, the photo
won’t look the same. So, let’s use a layer mask. This
works really well if there is a big contrast between
the subject and the background. There are several
steps:

Open it in GIMP (of course) and duplicate the layer.

With the duplicate
chosen, go to
Colors >
Saturation , and
slide the setting
clear down to the
left unti l the photo
is black & white.

Go to Colors >
Curves, and
adjust the curve
unti l the subject is
mostly black and
the background is
mostly white.

Go back to Colors and choose Invert. Copy this to
your clipboard using Edit > Copy Visible. Now, click
on the eye next to the copy in the Layers dialog to
make it invisible, and choose the color layer.

Right cl ick on the original layer and choose Add
Layer Mask. When the window comes up, the
default is White (Full Opacity). That’s what you want,
so click OK. Then go to Edit > Paste into selection .

In your Layers dialog you’l l see an anchor at the
bottom that has turned green. Click that to anchor
the pasted selection into the layer mask.

You’l l see that the background is gone, but you may
have some areas (l ike the hair on top of her head)
that are also gone. We’l l just fi l l those back in with a
white brush. This is the tricky part, so take it slow
and zoom in to get what you want. Depending on the
photo, you might have to fi l l in some skin, l ighter hair
and clothing as well (there’s a white tab on her
jacket, her l ighter hair, and her shoulder that I had to
work on.) Rather than fighting with the background
to put in all of her hair, I elected to just put in a bit

GIMP Tutorial: Removing A Background, Part 2
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and leave the rest out. I t doesn’t have all of her
l ighter highlights, but it came out pretty well . On the
left (previous page), how it looks in GIMP, and on the
right, the exported photo. I f you add it to a scene,
the white wil l be transparent.

Foreground Select

Our last method is foreground select.
Open the photo you want to use, and
choose the Foreground Select tool. I ’m
using this photo of a lion.

Draw a rough outl ine around the foreground object.
When you finish the outl ine, connecting the start and
finish, and press the Enter key, the background
outside your outl ine wil l turn blue and everything
inside the outl ine wil l be a lighter blue.

You’l l also see a small window at top right named
Foreground Select, and you’l l also see that your
mouse pointer has turned into a brush. Using the
brush (and it can be resized at left), paint over the
foreground you want to keep. I t wil l paint white, but
when you release your mouse button, the white wil l
disappear and you wil l see your foreground object.

When you’ve painted it the way you want, cl ick on
Preview in the Foreground Select window, and you
can see how it’s going to turn out. When you are
happy with it, press Select in that window, and your
paint wil l turn into a selection. Invert the selection
and press Delete.

This works better if the foreground and background
have more contrast than the photo that I used has. I
got a little extra green from the plants around the
lion’s mane. You can go in and fix it, but you have to
zoom in and paint it with a really small brush. Mostly,
it works well . Top, how it looks in GIMP, and bottom,
the exported fi le inserted on this white background.

I hope you’ve found a method that works for
whatever image you’re using!

GIMP Tutorial: Removing A Background, Part 2

http://www.commandlinefu.com
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by Paul Arnote (parnote)

Back in the early days of the web, we’d have to wait up to months sometimes for
an update – and new features – to our favorite web browser. These days,
updates for the various browsers seem to come more frequently than I fi l l the
gasoline tank on my pickup truck. You barely have time to get used to and try out
one version before the next version is coming out.

Back in the early days of the web, there were no more than two or three
competing web browsers. Today, there is an endless stream of browsers, each
offering their own special take on what the developers think a web browser
should be. Names like Brave, Vivaldi, Chromium, Konqueror, Midori, Basil isk,
Dil lo, Epiphany, Ephemeral, Flashpeak Slimjet, Waterfox, I ridium, Min, Netsurf,
Microsoft Edge, Palemoon, Otter, Seamonkey, and many others populate the
browser landscape. And all of these are just the ones I located during a cursory
look in the PCLinuxOS repository. I ’m certain that I missed a few … or more.
There are many more that aren’t in the PCLinuxOS repository.

Most publications would say that there are four “major” browsers: Firefox, Google
Chrome, Opera, and Microsoft Edge. Some might say there are five, adding in
Safari for MacOS/iOS. I call them the “big boys” of the browser world. But, for our
purposes, there are only three big boys on the block: Firefox, Google Chrome,
and Opera. Let’s exclude Safari, since it’s pretty much an exclusive MacOS/iOS
thing. I also exclude Microsoft Edge, not because it isn’t innovative (it is), but
because most Linux users distrust Microsoft so much that they refuse to install or
use Microsoft products on their Linux installation. Microsoft Edge is immeasurably
better than the old, recently retired hack called Internet Explorer. That part is
impossible to debate. Using the Chromium code-base for the new browser,
Microsoft Edge has even recently introduced very innovative and extreme-space-
saving TRUE vertical tabs. But Linux users’ collective distrust of anything
Microsoft is going to make Microsoft Edge a tough sell to Linux users, and Linux
is the “language” we speak around here.

I ’m only going to hit the highlights of the recent browser improvements and new
features. This won’t be an all-inclusive review of all that is new and better, so I ’m
sure to probably miss listing one of your favorite new features or improvements.
But I ’ l l try my best to l ist the most important of the “new and improved.”

Also, the list wil l be presented alphabetically, to avoid any “browser prejudice” or
“browser bias.” Those who regularly read my articles probably already know my
preferences, but I ’ l l also try to present the “new and improved” without bias or
judgement. However, there is one case among the “new and improved” features
that has the potential to introduce what could be a significant security
vulnerabil ity, and I won’t hesitate to point that out when we come to it. In theory,
the “new and improved” feature sounds like a great idea on the surface, but when
looked at objectively could also become quite the security issue.

Firefox

Firefox has been around
significantly longer than
either of it’s “big boy”
competitors. Even though its
market share has dwindled
as other browsers have
gained popularity, it remains
one of the true innovators in
the browser market. That
market share runs between
6% and just over 13% on the
desktop, depending on
which set of data you read or
believe. Firefox’s lack of
adoption on mobile
platforms, coupled with the
increased use of mobile
platforms, has been a
serious cause for Firefox’s
overall lackluster market
share numbers. On mobile

platforms, Firefox has less than a 1% market share.

On June 1, 2021, Mozil la released Firefox 89. The latest release includes a
reworking of much of the appearance of Firefox, as well as making it faster at
rendering pages. One of the goals of the development team in reworking Firefox
was to create, as much as possible, the same look and feel across all platforms.
So, your copy of Firefox on your desktop would look and feel similar (if not the

Browser Update Features You Might Have Missed
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same) to Firefox on Android, iOS, MacOS, Windows, BSD, etc. Below is a list of
some of what you wil l find in the latest Firefox.

Simplified toolbar: The Firefox toolbar is where you type a URL, so it’s where
the action starts. The new toolbar is simplified so you get to the good stuff
effortlessly. They removed visual clutter to focus on the most important navigation
items.

Streamlined menus: They consolidated extra menus to be more direct and
intuitive. The streamlined menu puts priority actions quickly at your fingertips.
They also reduced visual noise by removing unnecessary iconography and
provided clearer labels.

Inspired tab design: Floating tabs neatly contain information and offer cues only
when you need them, l ike visual indicators for audio controls. The rounded
design of the active tab signals the abil ity to easily grab and move tabs as
needed.

Updated prompts and fewer interruptions: They’ve removed unnecessary
alerts and messages. Where they do have messaging, the design and language
are clean and clear.

Cohesive, calmer visuals: Throughout the new Firefox, you’l l quickly notice
more consistent styl ing, l ighter iconography, a refined color palette, and a more
modern aesthetic for screens of all sizes — computers, phones and tablets.

Enhanced private browsing mode: All browsers have a private browsing mode,
but none match Firefox. The popular Total Cookie Protection moves from the
optional strict setting to always-on in private browsing. This feature maintains a
separate “cookie jar” for each website you visit while browsing privately. Any time
a site deposits a cookie, Firefox locks it up in its own cookie jar so that it can’t be
shared with any other website.

As stated on their blog entry from May 20, 2021, “While we make small design
improvements regularly, major overhauls are big undertakings that don’t come
around all that often since change can be hard. We took the Firefox redesign
project to heart with the goal of making your l ife a little better so you can worry
less, get more done and feel good about what’s on the horizon.”

Firefox is on a four-week release schedule for new releases.

Google Chrome

Released in September
2008, Google Chrome got
off to a relatively slow start.
Today, however, it is the
most widely used web
browser. Google Chrome’s
overall market share is right
around 65% of all browsers
on all platforms today. On
the desktop, Google
Chrome’s dominance
accounts for nearly 70% of
the market share. On mobile
platforms, Google Chrome
hovers right around a 64%
market share. The latter is
most l ikely due to the fact
that Google Chrome is the
default browser on Google’s
mobile platform, Android.

Google Chrome 91 is the latest version of the search giant’s browser, and was
released on May 25, 2021. Here’s some of what you might expect to see when
you fire up the newest version of Google’s browser.

Up to 23% faster. Thanks to a new JavaScript compiler named “Sparkplug,” the
newest version of Google Chrome claims to be up to 23% faster than previous
versions. "An important component of delivering a fast browser is fast JavaScript
execution," Thomas Nattestad, product manager for Chrome, wrote in a May 27
post to a Google blog .

Automatically start web apps. Under Google Chrome 91, web apps can be set
to automatically start when you log into your account, by right cl icking on the web
app icon.

Copy and paste local files into a web page. Starting with Google Chrome 91,
users can copy and paste local fi les from the fi le system straight into an email or
web page. Say you want to include a copy of your resume in an email. Go to your
local fi le system, copy the fi le to your clipboard, and then paste the fi le into your
email.

Web apps have local file read/write access. Specially written web apps now
have the abil ity to read and write local fi les to your computer. Remember I said

Browser Update Features You Might Have Missed
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there was something that could, conceivably, have serious security concerns?
This is it. While conceptually it sounds like a great idea to give web apps the
same fi le read/write access as installed programs, stepping back from it for a
broader view quickly reveals a situation RIPE for abuse. Don’t be surprised if this
becomes a new attack vector – very soon – from malware actors! I don’t have
sufficient “trust” that Google has placed appropriate safeguards in place to
prevent such activity. This article from web.dev explains the plus side of this new
abil ity in detail . This video from Google Chrome Developers on YouTube also
gives you a quick overview of fi le access by web apps.

Google Chrome currently releases a new version every six weeks. However,
starting in the 3Q of 2021, Google Chrome is planning to switch to releasing a
new version every four weeks.

Opera

Opera has always been a little “different. ” The Opera developers have always
approached the web browser with a different mindset, outlook and goals. Even
today, if you’ve never run Opera, you may find the Opera window quite foreign.
Some things are exactly where you think they should be (address bar, tab bar,
bookmarks, settings menu), but then there are other things that wil l leave you
scratching your head (hint: cl ick on the Opera icon at the upper left of the screen
to open up the Opera menu). Opera is different, but in good ways.

Opera has never had a majority share of the browser market space. Currently, it
has just under a 2.5% market share overall , and up to 3.5% market share on
desktops. On mobile platforms, that market share is somewhere between 2.2%
and 3.3%, depending on who’s numbers you read and believe.

We don’t cover Opera much here in The PCLinuxOS Magazine. So, some of the
“new” features we’re covering here may not be necessari ly “new” to long time

Opera users. I am a “sometimes” Opera user, but not enough to even classify
myself as an “occasional” user.

There’s one feature in Opera that I was completely unaware of unti l within the
past month. That feature, called “Workspaces,” actually debuted in Opera back in
late February, 2020. On a fresh installation of the browser, Opera comes with the
requisite one workspace setup. BUT … if you right cl ick on the workspace
(signified by the pentagonal “home plate” icon), you get a menu (left image
above).

Select “Manage workspaces…” from the menu. That wil l open the “Sidebar
Setup” dialog. At the top of that dialog is where you can add workspaces. Turn on
“Workspaces” by clicking on the slider to turn them on, and then simply click on
“+ Add more” at the top of the dialog (right image above). In the next window that
opens, you can select the icon you want to use to represent your new workspace.
My workspaces are represented by the “home plate” icon (required), and by a
star, a happy face, and a sun. You can turn off your additional workspaces by
unchecking the checkmark at the right side of the workspace in the list. You can
also completely turn off workspaces by clicking on the slider at the top to turn off
workspaces.

I ’m not sure, though, why anyone might want to turn them off once they
experience using workspaces. Workspaces ARE A GAME CHANGER! Once you
use them, you’l l wonder why every browser doesn’t make use of them.

Workspaces allow you to group your tabs into related … well, workspaces. These
allow you to work with a LOT less distraction than having all of your open tabs
visible at the same time. For example, when I ’m writing an article for the
magazine, it’s not uncommon for me to have a dozen or more tabs open at any
given time. Using workspaces, I can group together only the tabs that I need to
focus on as I write my article. This prevents me from becoming distracted, for
example, by incoming email. Switching between workspaces is as simple as
clicking on the workspace I want to change to, each with its grouping of open
tabs.

Browser Update Features You Might Have Missed
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Another thing with Opera involves browser extensions. Being a bit less “popular”
than the other “big boy” browsers, Opera typically doesn’t have the vast selection
of browser extensions available that the “others” have. Well, there is a way to
correct that.

Go here and install this Opera browser extension. This extension wil l al low you to
install Chrome browser extensions for use in Opera. The vast majority of Chrome
browser extensions work just fine in Opera, since both browsers use the same
rendering engine.

Opera releases are not regularly spaced, although most releases appear to come
out every six to eight weeks.

Summary

We don’t tend to cover new browser releases as much as we used to. They just
come out too frequently to be able to keep up with, and we don’t have the staff to
devote to such coverage.

Firefox has a few comparison charts of features between itself and competing
browsers. You might find it interesting to check it out to see how each compares
with one another.

These days, it’s fairly rare for users to use strictly one browser. While I tend to
use one particular browser 98% of the time, I do use other browsers for specific
tasks. I suspect that most users are also in the same boat.

The PCLinuxOS Magazine
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Get Your Free Copies Today!
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by Paul Arnote (parnote)

On May 19, 2021, the FreeNode IRC (Internet Relay
Chat) network exploded into controversy. Twenty to
thirty FreeNode staff members resigned their
positions, and created Libera Chat, a new IRC
network. FreeNode is considered the IRC home to
numerous FOSS projects, including PCLinuxOS.

As a result, many FOSS projects have abandoned
FreeNode. Most have gone to the newly formed
Libera Chat network. These FOSS projects include
Gentoo, Ubuntu, Wikimedia, CentOS, FreeBSD, and
Arch Linux, just to name a few.

The controversy over FreeNode sti l l rages like an
out of control wildfire. FOSS projects continue to flee
the carnage. Libera Chat, started by former
FreeNode staffers, went from startup to the sixth
largest IRC network literally overnight with all the
requests for new IRC channels and new registered
users. As you might imagine, the Libera Chat folks
have been slammed with requests, and now have a
backlog of new channel requests.

How Did This All Happen?

As with most things that have this much drama and
trauma involved, the details are a bit difficult to
extract. With two competing views of the actions
involved, it’s certainly difficult to discern exactly
where the real truth l ies. But let’s try to at least
provide a somewhat condensed timeline for the
events that led up to this fiasco. I t might just help
shine some light onto how this happened. As you
might imagine, this whole thing is, for lack of a better
word, messy.

FreeNode originally started as the Open Projects
Network (OPN) in 1998, before changing to their
current name in 2002.

In 2006, the FreeNode project originator, Rob Levin,
died in a car wreck. Levin’s brother wanted to turn it
into a business, but Christel Dahlskjaer, along with
help from Richard “RichiH” Hartmann, took over the
FreeNode project. She was an employee of Private
Internet Access when she took over control of
FreeNode’s parent corporation, FreeNode Limited.
She was the FreeNode “head of staff. ”

Dahlskjaer transferred ownership of FreeNode
Limited to tech entrepreneur Andrew Lee in 2017,
seeking a way to fund it more dramatically. Lee is
the founder of VPN provider Private Internet Access.
(In the interest of disclosure and transparency, I am
a customer of PIA, and it in no way impacts my
reporting of these events. )

In March, 2021, Dahlskjaer resigned from FreeNode
to pursue other l ife interests. A new head of staff was
not immediately appointed or named. In the power
vacuum that ensued, a senior staff member
assumed the role and asked for ownership of the
domain. Lee instead suggested a decentralization of
FreeNode. Shortly thereafter, Lee’s access to the
domain account was revoked. Despite being listed
as the domain owner, Lee was denied access to the

domain. Some former staff members painted this as
a hosti le takeover by Lee, and that brings us to the
current events that led to multiple senior members of
the FreeNode staff resigning.

I f you want more in depth information about the
FreeNode trials and tribulations, an internet search
wil l net you more reading material than you can read
in a day. I t was reported all across the computer
press outlets, so take your pick. To get you started,
here’s a search from DuckDuckGo. This l ink is
particularly tel l ing of the former staff members’ view
of things, along with each of their resignation letters
(or at least the ones who chose to share those
letters). This l ink (PDF, shared on TechRights.org) is
particularly tel l ing of Lee’s side of things. You be the
judge.

The Current Status

As a result, Lee ended up regaining control over
FreeNode. But, in the process, many of the IRC
channels that had been in place for years (including
#pclosmag , which I created) ended up with its
owners locked out. I t was as if everything had been
nuked. The same fate appears to have happened to
the #pclinuxos and #pclinuxos-support channels.
This self-destruction happened in mid-June.

FreeNode Destructs. What It All
Means For FOSS, PCLinuxOS
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I attempted to create a new channel for the
magazine, but inconsistent behavior with NickServ
(which manages registered user accounts) and even
more radical behavior from ChanServ (which
manages registered channels) resulted in extreme
difficulty in creating the new channel.

I ’d be trudging through the NickServ and ChanServ
commands, and then NickServ would get amnesia.
You can’t run ChanServ if NickServ can’t recognize
you as a registered user. So, I had to start all over,
first getting NickServ to recognize me as a
registered user, and then hope to get through all of
the ChanServ commands before NickServ caught
another case of amnesia. And, do it al l flawlessly.

That new channel, #PCLinuxOS-Magazine, is sti l l
up and running, as of the writing of this article.
However, it sti l l isn’t set up as I want, due to how
flaky NickServ and ChanServ are behaving. I just left
it in a state of “good enough for now.”

I do not know of the plans for the two main
PCLinuxOS channels on IRC yet. But, The
PCLinuxOS Magazine has decided to relocate to the
PCLOS-Talk server. Setting up the chat room for the
magazine was easy, and not fraught with the pitfal ls
of having to deal with the flaky behavior of NickServ
and ChanServ, not to mention the obscure, cryptic,
non-intuitive commands used to manipulate those
two services on IRC.

The move to the PCLOS-Talk server allows the
magazine to maintain a consistent chat service that
is available to any and all PCLinuxOS users who
wish to avail themselves of the feature. Running on
PCLOS-Talk, users can talk openly in the chat room
(pclinuxos-magazine), or take private conversations
to a private chat window.

You wil l , though, be required to sign up for an
account on the PCLOS-Talk server, if you haven’t
already and wish to join the magazine’s chat room.
Doing so is easy enough, and it’s free. Follow the
instructions in YouCanToo’s and Tuxlink’s article

from The PCLinuxOS Magazine’s March 2017 issue.
While you’re there, you can also drop into the
pclinuxos-talk and #chimpbox chat rooms to talk
about whatever you wish to talk about. By the way,
just about any topic is allowed to be discussed in the
magazine’s chat room, provided it’s not abusive,
obscene, or doesn’t fal l into a prohibited category
(pornography, etc. ).

What’s Next?

Just l ike anyone else, I can’t predict the future.

But, the #PCLinuxOS-Magazine channel on
FreeNode is currently (at the time of this writing) sti l l
up and running. However, I cannot say for how long.
There are multiple reports of channels being taken
over on FreeNode just for mentioning moving to
another network. FreeNode disallows “advertising”
or mentioning other networks. The new magazine
channel on FreeNode does mention in its topic that
the chat is moving/has moved to PCLOS-Talk. So I
may not have any say in how long that new channel
stays up or under my control. Even if it escapes

Top: The PCLinuxOS-Magazine chat room on PCLOS-Talk, running on Pidgin. Bottom: The logo for the PCLOS-Talk
service.

FreeNode Destructs. What It All Means For FOSS, PCLinuxOS
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being taken over for that violation, I do not plan to
keep the new channel up and running for too much
longer.

Summary

The PCLinuxOS Magazine has maintained a chat
presence on IRC ever since I became the editor 12
years ago. Had the kerfuffle at FreeNode not
occurred, we’d sti l l be there. But the sloppy way that
the “transfer” was handled during the power change
has necessitated a move to a new home.

IRC is old technology that predates the World Wide
Web, having started in August 1988. Tim Berners-
Lee didn’t even propose his idea for the WWW unti l
March 1989, seven months later. His vision wouldn’t
become reality unti l Christmas 1990. IRC has served
its purpose admirably during that ensuing time. I t
al lowed people to interact directly with one another,
across vast distances, in real time.

But it definitely has some areas that just don’t make
sense in today’s computing landscape. Messaging
on the web has evolved to include better, more
dynamic, more secure methods. IRC uses an
inordinate amount of bandwidth to send plain text
messages. I t’s insecure, and ripe for data
interception.

So, now is as good of a time as any to move on.
PCLOS-Talk runs on a custom XMPP server. I t’s
more secure, even if just for the fact that it requires
users to have an account, which means that users
have had some sort of vetting just to be able to
connect. IRC wil l al low anyone to connect, with or
without an account, increasing exposure to trol ls,
spammers, and others with malicious intent.

When one door closes, another one opens. Thanks
for the fond memories, FreeNode and IRC. You
served us well .

Screenshot ShowcaseScreenshot Showcase
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Posted by mutse, on June 16, 2021 , running Mate.
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by Meemaw

I recently took on a project at work which involved editing videos. I wasn’t sure
how to do that, or even what editor to use, but Shotcut and Avidemux were
recommended to me as good programs. Both have Windows versions as well ,
and both are in our repo. I chose Shotcut, knowing I could use it on my work
computer (Windows) and my home computer (PCLinuxOS, of course! ). I also
frequently take my work laptop to another office, and wanted to be able to work
there as well . While working on my project, I have gotten started learning
Shotcut. I won’t pretend I know everything about it, but this article might get you
started if you’re interested. Let’s explore.

Install ing Shotcut is very quick and easy. When you open it, you get the following
window:

Wow! There’s a lot of stuff there! Some of it you can close, but it’s actually
arranged pretty well , with some of the important items in tabs. Across the top of
the window are several tools you wil l use (Open, Save, Undo, Redo) plus buttons
for something you may have closed (Peak Meter, Playlist, Timeline or Filters).

Across the middle of the window is the Playlist, the New Project window, the

Recent Projects window, the Peak Meter (that’s the vertical l ine of numbers) and
the Jobs window. Below the New and Recent windows you wil l see the controls
for the player. Once you have a fi le to play, the New and Recent sections wil l be
replaced by the screen for the video player. You can start off by entering a name
for your project, and designating the folder you’re saving it to using the New
Project window. Or, you can start by adding some fi les to your Playlist. You can
choose Open, or you can position your fi le manager near Shotcut, highlight the
clips you want to use, and then click and drag them over to the Playlist window
on the left. Notice that at the bottom of the Playlist window, there are some tabs.
You’l l most l ikely see Playlist, Fi lters, Properties and Export. These are the tools
you’l l be using most of the time (however, I haven’t used Properties much). I f you
started off cl icking and dragging, be sure to click on File > Save As… and save
your project.

With video clips in your playlist, you can start by choosing the clip you want to
use first, and dragging it down to the bottom of the window into the Timeline.
When you have a video selected, the Properties tab shows the properties of that
particular cl ip. I t wil l show handy things like speed, duration, codec, resolution
and aspect ratio (next page, top left).

Video Editing With Shotcut
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Above the Timeline, you’l l see another toolbar. These are the tools you’l l use to
edit the clip (bottom of this page).

The hamburger at the left has another menu of additional tools that might be
used, such as adding another track or removing one. After that from left to right:
Cut, Copy, Paste, Append, Remove, Lift (remove clip without affecting the
position of the other clips), Overwrite clip onto the current track, Split at playhead,
Toggle snapping, Scrub while dragging, Ripple trim and drop, Ripple edits across
all tracks, Zoom in and out, and Zoom timeline to fit. I f you hover your mouse
over each, you wil l get these descriptions. Let’s look at each briefly.

Cut, Copy and Paste are just what they are everywhere else.

Append can insert a clip into your timeline, either at the beginning (if you’re just
starting) or after a track that is selected.

Remove can remove a clip or part of a clip.

Lift removes a clip without moving any of the other clips. I f you have 3 clips in a
row and you lift the center one, the space wil l remain.

Overwrite clip onto the current track lets you place a clip in the place of another
one.

Split at playhead allows you to choose a spot in your clip and cut it into two
pieces. The playhead is a vertical l ine that travels through the clip while it’s
playing to show you where you are.

Toggle snapping is one of the tools that works automatically when it’s toggled
on. I t shoves one clip up against the end of the clip before it without any effort on
your part.

Scrub while dragging lets you drag the playhead across your clip and it wil l play
at whatever speed you are dragging (instead of normal speed which may be too
fast for you) in order for you to be more precise on your split.

Ripple trim and drop is actually trim & drop which has a “ripple effect” - this
means that you can drop a clip in anywhere, but it wil l move every clip after it
over to the right, and if there’s a space between them, the space wil l stay.

Ripple edits across all tracks - You might have to experiment with this a bit,
because I ’m not sure I used it. However, the documentation says that Ripple trim
and drop has to be toggled on to use this one.

Zoom in and out is the slide bar with the plus and minus on each end. I t zooms
into the timeline so you can edit more effectively.

Zoom timeline to fit is just what it says. I f you click this, your video wil l be
zoomed out so the whole thing appears in the timeline.

Okay, now you have your clips in your Playlist and have dragged one down into
the timeline. Choose the one you want to use next and drag it down as well . I f
you have Toggle snapping on, the second clip wil l snap up against the end of
your first.

While my clips look identical,
they are only similar in that they
are successive clips of a drone
flying over a cow pasture. I
want to make them smoother
than just one clip snapped up
against the one before it. There
are a couple of methods of

Video Editing With Shotcut
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fading out of one clip and into another, and the first one’s fairly easy. Grabbing
the second clip, move it over the edge of the first. You’l l have to experiment with
your clips to see what works the best, but if you have 2 or 3 seconds that you can
overlap, it seems to work pretty well most of the time. As you can see in the
player, one clip is fading out in favor of the next. In the timeline, you can see the
overlap(it looks like a box with an X in it).

I f you have a soundtrack, make sure your speakers are finished speaking before
your overlap.

Another way to connect your clips with a smooth transition is to Fade In and Fade
Out. These are fi lters. In your main screen, the tab next to Playlist is Filters. With
a clip chosen, and the Filters tab chosen, you must Add a fi lter to see the list.

As you can see, there are
three sections in this
window: Favorite, Video
and Audio. With the clip
chosen, I selected Fade
Out Video. The program wil l
add a black triangle at the
end of the clip, and the
default is 1 second. I f you
hover your mouse over the
clip at the top, you can see
that your cursor has
changed to a finger and a
circle has appeared on the

end of the triangle. Moving the circle with your mouse wil l lengthen or shorten the
time your fade-out lasts. You might have to zoom into the clip to grab the handle.

You can see here that the clip is darker, and it fades out to black (although there
is a setting to change the opacity of the fade).

Many of the most-used fi lters are in Favorites and have an asterisk (*) to the left
of the title. I f you can’t find what you’re looking for, look in one of the other tabs,
and then make it a favorite by clicking on the asterisk on that l ine. I might use
Hue/Lightness/Saturation a bit, so I made it a favorite. When I go back to the
Favorites Menu, it is there.

In my editing I found a great variation in the volume of the individual cl ips. No one
wants to watch a video that they have to keep turning up and down, or a section
that blasts really loud, so another one of the useful fi lters is Gain / Volume. When
your video has an audio track, the Peak Meter (the vertical l ine of numbers to the
right of the player window). measures the volume.

Video Editing With Shotcut
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This clip is from a different video. You can see the volume in the Peak meter. This
particular cl ip was recorded loud, so I used the Gain/Volume fi lter to reduce the
volume so it was a bit less loud, and the same fi lter on the subsequent cl ip to
boost the volume a bit, aiming for something similar on each clip so the volume
on the whole video would be fairly uniform.

In the fi lter window you have a slide
bar to control the volume. I sl id the
bar to the left a bit to turn it down,
and replayed the clip, going back &
forth unti l it was where I wanted it.
I ’m sure there’s a better way, but
that worked for me.

Another fi lter I used was the Text
fi lter. You can use this to add text to
a clip. Again, make sure you have
selected the clip you want to use,
then click Filters. Text: Rich is in
Favorites, so add it.

Notice now that I have a big text box on the screen with formatting tools at the top
and a faint circle in the middle of the box. You can use your mouse to change the
font, size, alignment, etc. , before or after you add your text (after you add it, you
wil l , of course, have to highlight it). At left, you can choose size and position, plus
text size and background color. The Preset drop-down allows you to choose how
you want the text to appear on the screen, with choices like Slide in from left,
Slide out top and Slow zoom in (or out). I could have taken advantage of these,
but didn’t, as I had an email I wanted to display during all of the conclusion clip.

The handles at the corners help resize the text box and the circle in the center
lets you move it to your desired location. To get rid of the text box so you can see
the result, just cl ick on another fi lter or deselect the text fi lter.

Another thing you can do is add an audio track to your video. The ones I did for
work already had them, so I didn’t get too much experience with that, but cl icking
the hamburger menu in the Timeline, you can choose Timeline Operations >
Add Audio Track, and experiment. This video had no audio.

When you finish your editing, you can Export your work as a video fi le. Not
knowing enough about the types of video fi le formats, I chose to stay with the

Video Editing With Shotcut
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default. Here’s the Export window with the standard message. I t says “The
defaults create a H.264/AAC MP4 file, which is suitable for most users and
purposes. Choose a Preset at the left before deciding to use the Advanced
mode. The Advanced mode does not prevent creating an invalid combination of
options!”

I just stayed with the default. There’s a button that says Export File, so click on
that. You wil l see a window that gives you the opportunity to change the fi lename
and location if you wish, then it wil l export it. Be prepared for it to take a while
(some of mine were finished in 10 - 15 minutes). Longer videos wil l take longer to
export (my longest video was 19 minutes long when completed).

This so far is my experience with Shotcut. I intend to do lots more
experimentation, but if you have a project you want to do, you should be able to
get started with this short tutorial. You can find the video here.

I did an article on OpenShot in Sept, 2015. With all the problems that OpenShot
seems to be having at the moment, I think Shotcut may be a good substitute.

Agent Smith did an earl ier article on Shotcut in May of 2020.
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Servings 4
Unit converter

INGREDIENTS:

1 lb small red potatoes, halved (453 g)
4 pieces frozen corn on the cob mini ears,

thawed, cut in half
2 teaspoons oil (9.34 g)
2 teaspoons Old Bay™ seasoning (8.4 g)
1 lb (453 g) uncooked peeled deveined

extra-large shrimp (16 to 20 count)
12 oz fully cooked andouil le sausage,

sl iced (340.19 g)
1 lemon, cut into 8 wedges
1/4 cup chopped fresh parsley leaves (15 g)

DIRECTIONS:

1. Heat gas or charcoal gri l l . Cut 4 (18x12-inch)
sheets of heavy-duty foil . Spray with cooking spray.

2. Place potatoes in a microwavable bowl.
Microwave uncovered on High 5 to 6 minutes or unti l
potatoes are just tender. Add corn to potatoes;
drizzle with 1 teaspoon of the oil , and sprinkle with 1
teaspoon of the seasoning; mix unti l evenly coated.
Place shrimp in a medium bowl; toss with remaining

1 teaspoon oil and remaining 1 teaspoon seasoning;
mix unti l evenly coated.

3. Place an equal amount of sausage on the center
of each sheet of foi l . Dividing evenly, arrange potato
and corn mixture around sausage. Divide shrimp
evenly over sausage. Squeeze 1 wedge of lemon
over each pack.

4. Bring up 2 sides of foi l
so edges meet. Seal
edges, making tight 1/2-
inch fold; fold again,
al lowing space for heat
circulation and expansion.
Fold other sides to seal.

5. Place packs on the gri l l
over medium heat. Cover
gri l l ; cook for 6 minutes.
Rotate packs 1/2 turn;
cook 5 to 7 minutes longer
or unti l shrimp are pink
and sausage is heated
through. Remove packs
from the gri l l , cut large X
across the top of each
pack. Carefully fold back

foil ; sprinkle with parsley, and top with remaining
lemon wedges.

OPTIONS:

Two ears of fresh sweet corn can be substituted for
the frozen corn in this recipe. Cut each ear into 4
pieces.

To make in the oven, place packs on a cookie sheet.
Bake at 375F (162.7C) 23 to 25 minutes or unti l
shrimp are pink and sausage is heated through.

NUTRITION:

Calories: 540 Carbs: 35g Fiber: 4g
Sodium: 1120mg Protein: 40g

PCLinuxOS Recipe Corner Bonus

Foil Packet Low Country Shrimp

https://www.digitaldutch.com/unitconverter/volume.htm
https://greengiant.com/products/detail/green-giant-extra-sweet-mini-ears-of-corn-on-the-cob-12-ct-pack/
https://www.mccormick.com/old-bay/products/seasonings-and-sauces/old-bay-seasoning
https://en.wikipedia.org/wiki/Andouille
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
ti les with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multipl ier when tallying up your score.
Next, apply any additional scoring
multipl iers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your ti les in a set to
make your word. You wil l not necessari ly
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter ti les, here is a
list of how they are scored:
0 points: 2 blank ti les
1 point: E, A, I , O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z
6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter ti le set.
7. Have fun! I t's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks wil l be prefi l led
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w

n
lo

a
d

P
u

z
z

le
S

o
lu

ti
o

n
s

H
e

re

Possible score 264, average score 185.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/202107/files/2021-07-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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ARCHERY BASEBALL

BASKETBALL BIATHLON

BIKING BOXING

CANOEING CRICKET

CURLING CYCLING

DECATHLON DIVING

FENCING FIELD HOCKEY

FIGURE SKATING FOOTBALL

GOLFING GYMNASTICS

HOCKEY ICE HOCKEY

KARATE LACROSSE

PARASAILING RACING

RACQUETBALL ROCK CLIMBING

ROLLER SKATING RUGBY

SAILING SCUBA DIVING

SKI ING SOCCER

SOFTBALL SURFING

SWIMMING VOLLEYBALL

WATER SKI ING WHITE WATER RAFTING

WIND SURFING WRESTLING

Download Puzzle Solutions Here

T Y E K C O H E C I I R D G G C V Z H M G F R M G T C U D N

H G N I F R U S D N I W A T R U G B Y H A D J W D M H W D R

L L A B Y E L L O V Z F L G R B T Q H N M O D P G A L V O L

R E Z E H N V H K Z Q D N T B O A P U W F F S I G Z H I B O

V K E T A R A K J E B I P W R E S T L I N G S R U A L A J G

W C U T H O C K E Y L P R M L V O F B N K V V K O W P Q N L

C W I N R G E W B I K I N G T Y D E F E G Y M N A S T I C S

G Y W E C N V J A S O F T B A L L L N O W I Z K J M B D M G

N K C J Q I R S U J U X V O L L A B T E U Q C A R M Q J N N

I M O L Z E G N I L I A S A R A P R N J Z Z P T I G K D R I

F J B B I O S E W A T E R S K I I N G C R U F L W N N D O T

L Q G S O N F T E L P D X N R B F D I G A D C S X I P Z X F

O B S Y O A G T S I E S L G N I C N E F S K B I U M J K I A

G F F W G C O W P K C U X O G Y K H J C C I H Q G M L A N R

X U I I K H C T M U H H G U E O R M W O A T E K C I R C E R

L N U A I G S E B Y E C R N K P Z E R T J T C V B W F P X E

E Z G P S U N A R R V E E A I E P O H W A M H A O S R W K T

T G J R E E D I R H S J U E O X Y L H C I C S L W L O A J A

F W N A K I S I I K C D Q C U R O P Z N R E T G O X L S K W

H I F I V P Y B A K A X I L R N R B W D B A H N U N L P F E

N W E I V Y J T V C S I P W X I I X L A C R O S S E E K M T

I E N L J I I M H X X C C C C Q L T L J G L I P P R R S V I

I G C T D N D N C X E V L T Y M R L M N A V L V Y O S H Y H

F U E E G H O I W C U R L I N G Q A I S H L C I O F K S N W

Q K N T G Z O O I G R Y L A I N B C W E A W U W A I A R E M

H U X G O Z Z C C X G R L Z D A A X A B K W Y B A N T W P K

U P Y G X H R Z K L G B Z B H R W A T C Q L E O G M I X L Y

W N H N B B A S K E T B A L L I P O R X E F E B J X N N K V

D F Q Q Q N J E Z V Y L J D G L O W M L S W Q E A K G J D S

I I Q H S U R F I N G U O N J F A Y E L X B E R W R Q B I G
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1. A bat-and-ball game played between two teams of eleven
players on a field at the center of which is a 22-yard pitch
with a wicket at each end.

2. The art or sport of using a foil , épée, or saber in attack
and defense.

3. The act or practice of fighting with the fists, with or
without gloves.

4. An athletic contest consisting of ten track and field events
5. A winter sport combining cross-country skiing and
rifle shooting.

6. The sport of riding toward the shore on the forward slope
of a wave, especially while standing or lying on a board.

7. A game played with a bat and ball by two opposing teams
of nine players, each team playing alternately in the field
and at bat, the players at bat having to run through four
bases laid out in a diamond pattern to score.

8. A game played between two teams of five players each,
the object being to throw a ball through an elevated
basket on the opponents side of a rectangular court.

9. A football-type game in which play is continuous without
time-outs or substitutions, interference and forward
passing are not permitted, and kicking, dribbling, lateral
passing, and tackling are featured

10. A game played by two teams of 11 players each on a
rectangular, 100-yard-long field with goal l ines and
goalposts at either end, to gain possession of a ball and
advance it in running, passing or kicking plays across the
opponents goal l ine.

11. A game played on a rectangular field by two teams of ten
players each, in which participants use a long-handled
stick that has a webbed pouch on one end to try to propel
a ball into the opposing teams goal.

12. A game played on a large outdoor course with a series of
9 or 18 holes spaced far apart, to propel a small, hard ball
into each hole with as few strokes as possible.

13. The art, sport, or skil l of shooting with a bow and arrow.
14. A game in which two four-person teams slide heavy,

oblate stones toward the center of a circle at either end of
a length of ice.

15. A Japanese martial art in which sharp blows and kicks
are administered to pressure-sensitive points on the body
of an opponent.

16. An activity where a person is towed behind a boat
while attached to a specially designed parachute.Download Puzzle Solutions Here
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